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A360 Channel Manager  
Aviom’s A360 Channel Manager™ is a PC software application designed to simplify the 
configuration of A360 Personal Mixers that will be used in Custom mode. A360 Channel 
Manager allows Pro16e™ network slots to be assigned to the mix channel buttons of the A360 
as well as its Dual Profile Channel™ and One-Touch Ambience™ buttons. The resulting Mixer 
Configuration file can be saved to a USB memory stick for loading into the A360 
Personal Mixer.  
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What’s New

Version 3 of the A360 Channel Manager application adds support for channel, preset, and 
group naming and also simplifies integration with the iOS A360 Display app for the A360 
Personal Mixer.  

The new features include: 

•• New interface design 

•• New menu bar 

•• Cut/copy/paste text 

•• Name an A360 Personal Mixer 

•• Edit channel, preset, and group names 

•• Import names created using A360 Display    

•• Print configuration information 

•• Check for updates online 

Feature Overview 

The A360 Channel Manager software features include: 

•• Simple interface 

•• Mono and stereo mix channel support 

•• Editable channel, preset, and group names

•• Support for up to 64 input sources in the Pro16e network 

•• Assignable Dual Profile Channel 

•• Assignable One-Touch Ambience button 

•• 16 Mixer Configurations can be stored per USB device 

•• Stores 20 user-created mix presets in each configuration 

•• Allows easy backup of user mix presets created on the A360 Personal Mixer 

•• Provides an easy way to transfer mix presets from one A360 to another  
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It is recommended that you quit all running Windows applications before starting the Aviom 
A360 Channel Manager installation process. Check the Aviom website (www.aviom.com) for 
the latest information about software and firmware updates and the complete line of Aviom 
Pro16® and Pro64® Series products. 

Computer Requirements 

The minimum computer system requirements for running the Aviom A360 Channel Manager application 
are listed below.  

Windows

•	 Intel® or AMD® processor — 1 gigahertz (GHz) or faster 
•	 Intel, AMD, or 100% compatible motherboard & chipset
•	 Microsoft® Windows® 7 or 8 
•	 2 gigabyte (GB) RAM (32-bit systems) or 4 GB RAM (64-bit systems)   
•	 15 MB of free hard disk space for full installation 
•	 VGA Video (1024 x 768) - 256 colors 
•	 DirectX 9 graphics device with WDDM 1.0 or higher driver
•	 One available USB port for storing and loading configuration files  
•	 Microsoft .Net Framework 4.0

If your PC does not have the .NET Framework components installed, an Internet connection may be 
required to download and install these Microsoft components. 

The free Adobe® Reader (or equivalent) is required to open the included User Guide.  

Mac OS 

There is no official support for A360 Channel Manager running on Apple® Mac computers. 

A360 Firmware Requirements 

Firmware version 3.x or higher is required when using this version of A360 Channel Manager. Get firmware 
updates from the Aviom website; see the A360 Personal Mixer User Guide for information about updating 
the firmware in an A360 Personal Mixer. 

Installing A360 Channel Manager

www.aviom.com
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Start the Installation Process

Before installing the software, quit any running Windows applications. Locate the installer file, named 
“A360_Channel_Manager_Installer.exe,” and double-click it to begin the installation process. If an older 
version of A360 Channel Manager is already installed on the computer, it will be uninstalled during the 
new installation process. (Any user-created files are preserved.) You can uninstall a previous version of 
A360 Channel Manager manually by using the tools built into the Windows OS Control Panel. 

During the install, most screens give the option of navigating back to the previous step to review settings 
or make changes before continuing. To do this, click the Back button. (To exit the installer at any time prior 
to finishing, click the Cancel button; no software components will be installed.)  

Welcome Screens 

When the Welcome screens appear, click Next to continue and install A360 Channel Manager or click 
Cancel to exit without running the installer. 

Click the Next button to continue the installation process. 
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Software License Agreement

When the Software License Agreement page appears, read the agreement completely, click the 
I accept the terms in the license agreement radio button, and then click the Next button to continue the 
installation. 

Accept the Software License Agreement to continue. 

If you do not accept the software license agreement, the installer will exit without installing Aviom A360 
Channel Manager. 

Following the license agreement, the current ReadMe document will be displayed. Click Next to continue 
the installation, click Back to return to the previous page of the installer, or click Cancel to exit without 
installing the software. 



6A360 Channel Manager User Guide

Install

At this point, the installer has enough information to install the A360 Channel Manager application and 
its supporting files. On the screen that follows the ReadMe document, click the Install button to begin 
the installation. Click Back to return to the previous screen to review settings, or click Cancel to exit the 
installer.  

Click the Install button to start the software installation process.
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Software Security

If the PC prompts that verification is required to continue the software installation process, click Yes to 
proceed or click No to exit without installing A360 Channel Manager. 

Click Yes to continue the installation. 

Finish  the Installation  

When the install has finished, the following screen will be displayed. Click the Finish button to complete 
the installation process. 

Click the Finish button to exit the installer.
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After the installer closes, A360 Channel Manager is ready to use (assuming that all required Microsoft 
updates and .NET Framework components are correctly installed). 

Launch A360 Channel Manager by double-clicking its icon either from the desktop or in the A360 Channel 
Manager application folder (C:\Program Files (x86)\Aviom\A360 Channel Manager), or by selecting A360 
Channel Manager from within the Aviom folder in the All Programs section of the PC Start menu. 

P Note: The default location for the installation is  
C:\Program Files (x86)\Aviom\A360 Channel Manager\A360 Channel Manager.exe 

A desktop icon is installed automatically. 

Updating or Removing the Application 

When a new version of A360 Channel Manager is available, the old version of the application will be 
removed automatically in the process of installing a new version. 

If you want to manually remove A360 Channel Manager, an uninstall shortcut is placed in the A360 Channel 
Manager folder automatically during the initial installation. The utility can be accessed directly from the 
Aviom\A360 Channel Manager folder created in the All Programs menu. Optionally, the application can be 
removed by using the standard Windows OS utilities found in the Windows OS Control Panel.  

An uninstall shortcut is placed in the All Programs menu.  

As a precaution, back up any files in the A360 Channel Manager folder that you wish to save before 
proceeding with the uninstall and update procedure. The uninstall utility removes all program files, 
product-specific update files, application icons, log files, registry entries, and text files associated with 
A360 Channel Manager.  It does not delete any user-created files.  
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What Gets Installed

A360 Channel Manager is installed by default into the following folder:  
C:\Program Files (x86)\Aviom\A360 Channel Manager  

Within the A360 Channel Manager folder, which contains the application’s resources, the Documents folder 
containing user documentation, the software license, and ReadMe files will also be created. (The free 
Adobe Reader, or equivalent, is required to open the included User Guide.) 

P  Note:  Do not rearrange or move any of the files or folders created during the installation. 



10A360 Channel Manager User Guide

Using A360 Channel Manager  
A360 Channel Manager makes it easy to create, save, and edit custom channel configurations 
for the A360 Personal Mixer. Each performer’s Personal Mixer can load a unique channel map 
that assigns network slots to the mixer’s channel buttons. The software can edit and save up 
to sixteen unique Mixer Configuration files to a disk. In addition, A360 Channel Manager offers 
an easy way to back up user-created Mix Preset files that have been saved to a USB memory 
device from an A360 Personal Mixer as part of a configuration file.  

Window Components 

The A360 Channel Manager interface consists of a main window with two views—Channel Assignment 
and Preset/Group Names. Each can be accessed via the keyboard shortcuts F5 and F6. The default view is 
the Channel Assignment View.  

The Channel Assignment view 
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The Name Presets/Groups view 
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Channel Assignment Editing Tools 

Information about the current Mixer Configuration being edited is shown in five columns. 

76543

21

	    Function

 1 Configuration Number Being Edited

 2 A360 Personal Mixer Name 

 3 A360 Channel Button 

 4 Channel Name 

5 Stereo Link Mono/Stereo setting 

6 Network Slot Assignment 

7 Channel Status
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Configuration Number  

The read-only Editing: field shows the number (1-16) of the configuration currently be edited when you 
open a saved configuration from disk. This field will read New if you start editing a configuration prior to 
loading or saving. 

A360 Personal Mixer Name

The Mixer Name: field shows the A360 Personal Mixer name that is stored in the A360. The mixer’s name 
will appear in the Mixer Name field any time a saved configuration is opened from disk. To change the 
name, click to edit; up to 12 characters of text can be used. When you create a new configuration without 
opening one from disk, the default name A360 is displayed.  

P  Note:  If you want to have a unique Mixer Name for each A360 in your system, be sure to save 
different configurations for each one on a USB stick with a different name saved in the Mixer 
Name field for each. If you load the same configuration into multiple A360 Personal Mixers, 
they will all take on the same Mixer Name.  

While editing, the Cut, Copy, Paste, And Delete functions are also available. They can be accessed from the 
Edit menu, by right-clicking in a text field, or by using the keyboard shortcuts:

•• Cut	   Ctrl+X

•• Copy	   Ctrl+C

•• Paste	   Ctrl+V

•• Delete	   Del  

Text editing commands are available in the edit menu and the right-click contextual menu. 
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A360 Channel Button 

The Channel Button column has read-only entries that correspond to the A360 Personal Mixer’s sixteen 
mix channels, plus the Dual Profile Channel and Ambience buttons.  Each row shows the full setup for one 
channel button. 

Each row shows a complete record for one channel button on the A360. 

Channel Name 

Each mix channel on the A360 can be given a unique name of up to 8 characters. Channel names are part 
of a configuration and are used by all Mix Presets saved with the configuration. The channel names are 
stored in the A360 itself. While editing, the Cut, Copy, Paste, And Delete functions are also available. They 
can be accessed from the Edit menu, by right-clicking in a text field, or by using the keyboard shortcuts. 

Channel names can also be created and edited by using the A360 Display iOS app. Any configurations 
saved from the A360 to a USB memory device will include channel, preset, group and mixer names. These 
names can be edited with A360 Channel Manager when a configuration is opened. 

Mono/Stereo Radio Buttons 

Each mix channel button on an A360 Personal Mixer (as well as the Dual Profile Channel and Ambience 
buttons) can be assigned either a mono or stereo source from the 64 Slots available in the Pro16e network. 
The Stereo Link status for each mix channel button on the A360 can be independently set to either Mono 
or Stereo using the radio buttons. 
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P  Note: The Stereo Link switches on network’s analog input devices, digital console cards, or D800-
Dante A-Net Distributor must be set correctly to make configurations created with A360 
Channel Manager work predictably. Make sure that the settings coincide between the input 
device(s) and the configurations made for all A360 Personal Mixers in the system to avoid 
unpredictable results.  

A-Net In

Power

v.2Mono Stereo Mono Stereo Mono Stereo Mono Stereo Mono Stereo Mono Stereo Mono Stereo Mono Stereo

Channels 1-2 and 3-4 are set as stereo pairs. 

When editing a configuration, changing a stereo channel to mono (or vice-versa) will automatically clear 
the Slot Assignment for the channel button being edited.  Its Status column will be set to Unassigned.  See 
“Channel Status” on page 19.  

The Slot Assignment is automatically cleared when a channel’s Stereo/Mono button is changed.
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Network Slot Assignment 

The Slot Assignment column consists of two drop-down menus: one for Mono channel buttons and 
the other for Stereo. The drop-down menu will automatically update to display a mono or stereo Slot 
Assignment list as the Stereo Link radio buttons are changed for each channel.  

Only network slot numbers are displayed; the use of a text-based input list is suggested to keep track of 
the audio sources connected each device’s inputs. A sample input list appears as a reference at the end of 
this document.  See “Sample Input List” on page 28.  

Mono Channels 

The mono drop-down contains 65 entries—network slots 1 through 64, plus the double dash ‘‘- -‘‘ 
character used to indicate that no network slot is currently assigned to the channel button. 

Select a mono network slot from the menu. 

To change a mono channel button’s assignment, click to open the drop-down menu associated with the 
channel and then choose the desired network slot from the list. (Choose “- -” to have no slot assignment 
for the channel.) Slot assignment conflicts are indicated by an Error in the Status column; conflicts will 
need to be resolved prior to saving the Mixer Configuration to disk. The most common error is caused 
when two channels are assigned to use the same network slot.  

Remember that the stereo/mono settings between the mixer configurations you create and the network’s 
input devices must match.  
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Stereo Channels 

The drop-down menu for stereo channels contains 33 entries shown as pairs of odd-even network slots 1/2 
through 63/64, plus the double dash ‘‘- -‘‘ character used to indicate that a channel button is unassigned. 

To change an assignment for a stereo mix channel button, click to open the drop-down menu associated 
with the channel and then choose the desired pair of network slots from the list. (Choose “- -” to have no 
slot assignment for the channel.)   

Selecting a stereo network slot from the drop-down menu  

Slot assignment conflicts (indicated by an Error in the Status column) will need to be resolved prior to 
saving the Mixer Configuration to disk. 
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Ambience 

The Ambience button’s drop-down menus for mono or stereo slot selection are unique—each includes 
an entry for Onboard Mic instead of the double-dash (unassigned) character.  The Onboard Mic is always mono. 

The Ambience button includes a selection for the Onboard Mic. 

To assign a mono or stereo network source to the Ambience channel, set the  Stereo Link radio button first 
and then choose mono or stereo slots for the channel. 

P  Tip:  The Ambience channel makes it easy to use room mics with your monitoring system. Assign 
mono or stereo mics to the network and then pick those Slots for the Ambience channel 
rather than using the A360’s onboard mic. 
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Channel Status 

The Channel Status column has three states: OK, Unassigned, and Error. The Status will update as changes 
are made to the Stereo Link and Slot Assignment columns for each channel, and as Mixer Configurations 
are loaded from disk for editing. 

A configuration being edited with the three channel Status states is shown.   

The OK Status indicates that a mix channel’s network slot assignment has no conflicts with the other mix 
channel button assignments in the current Mixer Configuration. 

When the channel’s Status reads Unassigned, this indicates that no network slot is currently assigned 
to the channel button. Mixer Configurations may be saved with some channels set to Unassigned, but 
note that at least one of the mix channel buttons (or the Dual Profile Channel) must be assigned to use 
a network slot before a Mixer Configuration can be saved. The Save function will be unavailable until all 
channel conflicts are resolved and at least one mix channel button is assigned to a network slot. 

P  Note: Any Channel Buttons that are Unassigned will not be able to be selected when the A360 
Personal Mixer is in Custom mode. 

The red Error status indicates that a channel has a conflict—this is usually caused during editing by 
assigning the same network slot (or pair, if stereo) to more than one channel button. A Mixer Configuration 
cannot be saved until all conflicts are resolved.   
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Preset and Group Naming 

Choose Preset/Group Names from the View menu to access the editing tools for the Mix Preset and Group 
names saved with a configuration (keyboard shortcut F6).  

Open the Mix Presets and Group name tools from the View menu or by pressing the F6 key. 

Mix Preset and Group names can have a maximum of 8 characters. The Cut, Copy, Paste, and Delete text 
editing functions are available from the Edit menu or right-click contextual menu. 
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Disk-Based Functions 
A360 Channel Manager can save up to sixteen Mixer Configurations to a disk. The drive 
location and Mixer Configuration selection is available from the File menu. 

Save and open configurations using the File menu options. 

Create a New Mixer Configuration 

Use the New command in the File menu to create a default Mixer Configuration. 

In a default configuration:

•• The Editing field is set to read New

•• The Mixer Name field is set to A360

•• Channel names are returned to the defaults (Chan 1, Chan 2, etc.) 

•• All channels are stereo 

•• Slot Assignments are in sequential order 

•• The Ambience channel is set to use the Onboard Mic 
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Open a Configuration  

The File menu’s Open... command is used to choose a storage device connected to the PC from which a 
Mixer Configuration and its associated Mix Presets and Group names will be loaded for editing in A360 
Channel Manager. If no external device is connected, the default boot drive is automatically selected 
(typically this is C:\). 

Mixer Configurations and Mix Presets are saved to a specific file and folder structure at the root of the 
storage device. Mixer Configurations use the suffix “.acg.” 

Select a configuration to load it for editing. 

P  Note: Do not move or rename the folders, Mixer Configuration, or Mix Preset files. 

Loading a Mixer Configuration also loads any Mix Presets associated with the configuration. Although the 
Mix Presets’ channel-level settings (volume, pan, etc.) cannot be edited, the names of the Mix Presets and 
Groups can be edited. Mix Presets will be saved when the Mixer Configuration is saved to disk and will be 
loaded into the A360 when the Mixer Configuration is recalled from a USB memory device. 
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Save a Configuration 

The File menu contains two save functions—Save... and Save As...—that are used to store up to 16 
configurations on a PC’s local disk or connected USB memory device.

If no external device is connected, the default boot drive is automatically selected (typically this is C:\). 
Mixer Configurations and their associated 20 Mix Presets are saved to the root of the storage device within 
the Aviom folder. (The Aviom folder and its underlying folder structure will be automatically created the 
first time a Mixer Configuration is saved if they do not already exist.)

Using the Save... command for the first time will open a dialog box with drop-down menus that allow you 
to select the Drive where configurations will be stored, and the Configuration Number to be used. 

Choose a location where the files will be saved.  

Click the OK button to save the Configuration to the selected location or click the Cancel button to return 
to A360 Channel Manager without saving. If you continue editing and want to save the new changes, use 
the Save command again; the file on disk will be overwritten without opening the dialog box. If you want 
to save the Configuration to a different location after making changes, use the Save As... command which 
will automatically open the disk and configuration number selection dialog box.   

Storage Devices 

The Mixer Configuration and Mix Preset files created with A360 Channel Manager are saved to the root 
directory of the selected storage device. The folder path used for file storage is C:\Aviom\mixer_config_
files\banka. Do not change the folder locations or file names. Storage devices must be PC formatted. 
Devices may be partitioned, but non-PC partitions will be ignored. 
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P  Note: A PC-formatted USB memory stick is required to load Mixer Configurations and Mix Presets 
into an A360 Personal Mixer. Recalling a configuration from a USB device will replace any 
previously loaded configuration plus all Mix Presets in the A360. Recalling a configuration 
also loads channel names and the name assigned to the A360 Personal Mixer. 

When saving a Mixer Configuration created on the PC to disk for the first time, a warning dialog box will 
appear if no Mix Preset files are associated with the newly created Mixer Configuration. Click Yes to create 
a default set of Mix Presets; the Mixer Configuration is saved to disk and a folder of 20 Mix Presets (16 
standard plus 4 Instant Mix Recall presets) associated with that Mixer Configuration is also created.  

Click Yes to save the configuration and create a set of default Mix Presets. 

Click No in the dialog box to proceed without creating any Mix Presets. You may want to do this, for 
example, if a configuration was loaded into an A360 and the user has started creating and saving Mix 
Presets in the A360, and you now want to change the assignment of the Ambience button to network 
audio instead of the built-in mic. 
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What Gets Saved 

When a Mixer Configuration is saved to disk with Mix Presets, the  files written to disk look like the example 
seen below. Each saved Mixer Configuration is saved with a number and the “.acg” extension; the Mix 
Presets associated with that Mixer Configuration are in a folder named “Preset_Group_nn” where “nn” is the 
same number as the Mixer Configuration. 

This graphic shows the disk-based file structure for eight Mixer Configurations and their Mix Presets.  
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Within a Preset_Group_nn folder are the 16 Mix Presets that are associated with the 16 mix channel 
buttons on the A360 along with the four Mix Presets that are associated with the four Instant Mix Recall 
buttons. The 16 mixes associated with the mix channels on the A360 are saved with the name “Preset_nn 
(1-16)” and the “.amp” extension; the four mixes associated with the Instant Mix Recall buttons are saved 
with the name “Preset_IMR_nn (A-D)” and the “.amp” extension.  

Each Preset_Group folder contains 20 Mix Preset files. 

P  Note: Do not move or rename the Mixer Configuration or Mix Preset files; they will not be 
recognized by the A360 if changes are made to the file structure.   
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Copying Mixer Configurations 

If Mixer Configurations (and their associated Mix Presets) are created on an internal storage device on a PC, 
they can easily be copied to a removable USB storage device for loading into an A360 Personal Mixer. 

To copy all 16 Mixer Configurations and their Mix Presets to a removable device:

1.	 Connect a PC-formatted memory stick or other removable USB storage device to the 
computer.

2.	 Locate the Aviom folder at the root of the current disk that was used for Mixer 
Configuration storage.  

3.	 Click to highlight and select the Aviom folder. 

4.	 Right-click and choose Copy from the contextual menu (or use the shortcut Control-C).  

5.	 Navigate to the root of the external storage device. 

6.	 Right-click and choose Paste from the contextual menu (or use the shortcut Control-V). 

7.	 The Aviom folder and its folder structure along with the sixteen Mixer Configurations and 
their Mix Presets are written to the external device.  

8.	 Eject the external storage device.

9.	 Connect the external device to the A360 Personal Mixer and load a Mixer Configuration 
according to the instructions provided below.  

Recalling a Mixer Configuration on the A360 

Once a Mixer Configuration and its associated Mix Presets have been saved onto a USB memory device, 
the configuration can be loaded into the A360. Loading a configuration replaces the Mix Presets and any 
previously loaded configuration in the A360; there is no undo. 

To recall a configuration: 

1.	 Connect the USB memory device to the USB port on the rear of the A360 Personal Mixer. 

2.	 Move the rear-panel switch on the A360 to the Program position; The Save and Recall LEDs 
flash and the A360 mixing interface is temporarily disabled. 

3.	 Press the Recall button. 

4.	 The Save LED goes out and all 16 mix channel buttons begin to flash. 

5.	 Press the numbered mix channel button that corresponds to the configuration you wish 
to load. 

6.	 The yellow Mute LEDs beneath the mix channel buttons light in sequence as a 
confirmation that the configuration has been loaded successfully. 

7.	 Move the rear-panel switch on the A360 to the Custom position to use the new channel 
layout and Mix Presets. 

8.	 The USB memory device can be safely removed. 

P  Note:  When a Mixer Configuration file is loaded from a USB device it replaces any previously loaded 
channel configuration; all Mix Presets in the A360 are replaced with those stored in the Mixer 
Configuration. 
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Sample Input List  

Print this input list to simplify network slot management.

 

Device   Input   Source Stereo

1 L

2 R

3 L

4 R

5 L

6 R

7 L

8 R

9 L

10 R

11 L

12 R

13 L

14 R

15 L

16 R

1 L

2 R

3 L

4 R

5 L

6 R

7 L

8 R

9 L

10 R

11 L

12 R

13 L

14 R

15 L

16 R
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SOFTWARE LICENSE AGREEMENT

This software license agreement (this “Agreement”) is made by and between AVIOM, INC., a 
Delaware corporation (“Aviom”), and the individual or entity desiring to install or use the Software (as 
defined below) (“Licensee”).  By clicking the “I Agree” button, Licensee: (1) represents that Licensee has 
read this Agreement in its entirety and understand its terms and conditions; and (2) agrees to each of the 
terms and conditions of this Agreement.  If you do not agree to each of the terms and conditions of this 
Agreement, then you must click the “I Decline” button and you may not install or use the Software.

Definitions.

“Aviom Product” shall mean the product of Aviom into which the Firmware is intended 
to be installed.

(a)	 “Firmware” shall mean the firmware provided by Aviom that is intended to be installed 
into a specific product of Aviom.

(b)	 “Installation Software” shall mean the software provided by Aviom to enable Licensee to 
install the Firmware into the Aviom Product.

(c)	 “Software” shall mean both the Installation Software and the Firmware, collectively.

1.	 Grant of License.  Subject to the terms and conditions of this Agreement, Aviom grants Licensee 
a limited, non-exclusive license to the object code version of the Software (the “License”).  The License 
permits Licensee to install and use the Installation Software on a single workstation and use the Installation 
Software to flash the Firmware into the Aviom Product(s).  The License also grants Licensee the right to use 
the Firmware on all Aviom Products owned by Licensee.  Licensee may also use the documentation included 
with the Software, if any, (e.g. help files, release notes, and readme.txt files) (collectively, “Documentation”) 
as is reasonable and necessary for Licensee to use the Software.  

2.	 Compensation.  There is no charge for use of the Software by Licensee under the terms and 
conditions of this Agreement.  

3.	 Ownership.  Licensee acknowledges that: (a) the Software is and shall remain the exclusive 
property of Aviom and Aviom’s successors and assigns; (b) Licensee has no right or interest in the Software 
or the Documentation other than as expressly granted in this Agreement; (c) nothing in this Agreement shall 
be construed as a sale of the Software or the Documentation to Licensee; and (d) all intellectual property 
rights shall remain with Aviom and the Agreement shall not transfer any intellectual property rights in, or 
associated with, Software or the Documentation to Licensee. 

4.	 Transfer of License; Copy Protection.  Licensee may not rent, loan, transfer, sublicense, lease or 
otherwise distribute or operate all or any part of the Software to or for the benefit of any third party.  Licensee 
may not assign all or any part of its rights or obligations under this Agreement without Aviom’s prior written 
consent and any attempt to the contrary will be void and a material breach of this Agreement.  Aviom may 
withhold such consent in its sole discretion.  

Other Restrictions.  Licensee may not reverse engineer, decompile, disassemble, modify or create derivative 
works of all or any part of the Software or otherwise derive the source code to all or any part of the Software.  
Without limiting the generality of the foregoing, Licensee shall not use a debugging tool to examine, operate 
or alter all or any part of the Software or run all or any part of the Software through a disassembly or source 
extraction system of any kind or create any derivative work of all or any part of the Software.  Licensee 
agrees that any information obtained in violation of the restrictions as set forth in this Section 6 will be 
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Confidential Information automatically and irrevocably deemed assigned to and owned exclusively by 
Aviom.  Licensee will ensure that all marks, notices or legends pertaining to the origin, identity or ownership 
of the Software or the Documentation remain intact and clearly legible.  Notwithstanding anything contained 
in this Agreement to the contrary, if Licensee is located in the European Union and Licensee determines that 
access to the source code to the Software is necessary to achieve interoperability of the Software with other 
programs, then Licensee may reverse engineer the Software provided that: (a) Aviom has not already made 
available to Licensee the information necessary to achieve interoperability; and (b) Licensee limits its reverse 
engineering activities to those parts of the Software which are necessary to achieve interoperability with such 
programs.
Copyright.

(a)	 The Software and the Documentation contain proprietary material of Aviom and/or material 
that other software and/or information suppliers have licensed to Aviom for use in the Software.  This 
material is protected by copyright and other laws respecting proprietary rights.  Aviom and/or its licensors 
retain all rights in the Software and the Documentation, including (without limitation) all copyright and 
other proprietary rights worldwide in all media.  Licensee may not use all or any part of the Software or the 
Documentation except as expressly permitted under this Agreement and under U.S. and/or other applicable 
copyright laws.

(b)	 While Licensee may make a reasonable number of copies of the Software and the 
Documentation solely for archival/back-up purposes, no part of the Software or the Documentation may 
be used, reproduced or duplicated in any medium or format beyond the express terms of this Agreement 
without prior written authorization from Aviom.  Any use or reproduction not authorized by this Agreement is 
prohibited and shall immediately terminate this Agreement.

(c)	 Licensee acknowledges that the Software and the licensed materials therein are highly 
proprietary in nature and that unauthorized copying, transfer or use may cause Aviom irreparable injury that 
cannot be adequately compensated for by means of monetary damages.  Licensee agrees that any breach 
of this Agreement by Licensee may be enforced by Aviom by means of equitable relief (including, but not 
limited to, injunctive relief) without the necessity of posting any bonds in addition to any other available 
rights and remedies.

5.	 Termination.

(a)	 Termination.  If Licensee: (i) makes or distributes, or fails to prevent others in its control 
from making or distributing, copies of the Software or the Documentation (except as expressly permitted by 
this Agreement) or modifications or derivations thereof; or (ii) breaches any provision of this Agreement, 
then this Agreement shall terminate automatically.

Effect of Termination.  Upon any termination of this Agreement, Licensee shall: (i) immediately discontinue 
use of the Software and the Documentation; (ii) remove the Installation Software and the Documentation 
from all of Licensee’s workstations; and (iii) delete and destroy all copies of the Software and the 
Documentation in its possession or control. Sections 4, 5, 6, 7, 8(b) and 9 through 12 shall survive the 
termination or expiration of this Agreement for any reason in accordance with their respective terms.  

6.	 Disclaimer of Warranties.  AVIOM LICENSES AND PROVIDES THE SOFTWARE AND 
THE DOCUMENTATION TO LICENSEE ON AN “AS-IS” BASIS.  AVIOM HEREBY DISCLAIMS 
ANY AND ALL WARRANTIES AND CONDITIONS WITH REGARD TO THE SOFTWARE AND THE 
DOCUMENTATION, INCLUDING, BUT NOT LIMITED TO, ALL IMPLIED WARRANTIES AND 
CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, ACCURACY, 
TITLE AND NON-INFRINGEMENT.
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7.	 Limitations of Liability.

(a)	 General.  IN NO EVENT WILL AVIOM BE LIABLE FOR DAMAGES ARISING OUT 
OF THE USE OR LICENSING OF THE SOFTWARE OR THE DOCUMENTATION OR ARISING 
UNDER THIS AGREEMENT, WHETHER IN TORT, CONTRACT OR OTHERWISE, TO LICENSEE OR 
ANY OTHER PERSON OR ENTITY INCLUDING ANY DAMAGES CAUSED TO AVIOM PRODUCTS 
FROM USE OF ALL OR ANY PART OF TH E SOFTWARE.

(b)	 Consequential Damages, Etc.  AVIOM SHALL IN NO EVENT BE LIABLE 
TO LICENSEE OR ANY OTHER PERSON OR ENTITY FOR ANY LOST PROFITS, OR 
CONSEQUENTIAL, INCIDENTAL, INDIRECT, PUNITIVE, SPECIAL, OR SIMILAR DAMAGES, 
INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF DATA, DAMAGES TO 
HARDWARE INCLUDING BUT NOT LIMITED TO AVIOM PRODUCTS, IMPAIRMENT OR 
LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, AVIOM 
PRODUCT FAILURE OR MALFUNCTION, LOSS OF WORK PRODUCT, OR ANY AND ALL OTHER 
COMMERCIAL DAMAGES OR LOSSES, DIRECT OR INDIRECT, WHETHER IN TORT, CONTRACT, 
OR OTHERWISE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

(c)	 THE LIMITATIONS OF LIABILITY SET FORTH IN THIS SECTION (I) REFLECT 
AN ALLOCATION OF RISK GIVEN THE AMOUNTS PAYABLE UNDER THIS AGREEMENT 
AND (II) SHALL REMAIN FULLY OPERATIVE EVEN IF THE LIMITED REMEDY SET FORTH 
IN THE AGREEMENT FAILS OF ITS ESSENTIAL PURPOSE OR IS OTHERWISE HELD TO BE 
UNENFORCEABLE.

8.	 Export Regulations.  The transfer of technology across national boundaries is regulated by the U.S. 
Government.  Licensee agrees that Licensee shall not: (a) acquire, ship, transport, export or re-export the 
Software, directly or indirectly, into any country in violation of any applicable law (including, but not limited 
to, the United States Export Administration Act and the regulations promulgated thereunder); or (b) use the 
Software for any purpose prohibited by such laws.

9.	 Miscellaneous.

(a)	 Governing law; Jurisdiction.  The validity, interpretation, rights and obligations of the 
parties and any dispute arising under this Agreement shall be governed by the laws of the Commonwealth 
of Pennsylvania applicable to contracts between residents of Pennsylvania and wholly performed in 
Pennsylvania.  Neither the United Nations Convention on the International Sale of Goods, the 1974 
Convention on the Limitation Period in the International Sale of Goods, nor any amendment or protocol to 
either of the foregoing shall apply to this Agreement or the activities undertaken under or in respect of this 
Agreement.  The state and federal courts with jurisdiction over Chester County, Pennsylvania shall have 
exclusive jurisdiction over any case, controversy or dispute concerning this Agreement or its performance or 
the Software; provided that Aviom may seek injunctive relief in any court of competent jurisdiction.

(b)	 Severability.  If any provision of this Agreement shall be determined to be void, invalid, 
unenforceable or illegal for any reason, then the validity and enforceability of all the remaining provisions 
hereof shall not be affected thereby.

(c)	 Failure to Exercise Rights.  The failure of either party to exercise any of its rights under 
this Agreement for a breach thereof shall not be deemed to be a waiver of those rights or a waiver of any 
subsequent breach of the same or any other provision.

(d)	 Titles.  The titles of the Sections of this Agreement are for convenience only and do not in 
any way limit or amplify the terms and conditions of this Agreement.
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(e)	 Entire Agreement.  This Agreement constitutes the entire understanding between the parties 
with respect to the subject matter of this Agreement and supersedes any and all prior and contemporaneous 
understandings, statements, warranties, representations and agreements, both oral and written, relating 
thereto.  This Agreement cannot be modified except in a writing signed by the party against whom 
enforcement is sought.
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SOFTWARE LICENSE AGREEMENT

This software license agreement (this “Agreement”) is made by and between AVIOM, INC., a 
Delaware corporation (“Aviom”), and the individual or entity desiring to install or use the Software (as 
defined below) (“Licensee”).  By clicking the “I Agree” button, Licensee: (1) represents that Licensee has 
read this Agreement in its entirety and understand its terms and conditions; and (2) agrees to each of the 
terms and conditions of this Agreement.  If you do not agree to each of the terms and conditions of this 
Agreement, then you must click the “I Decline” button and you may not install or use the Software.

Definitions.

“Aviom Product” shall mean the product of Aviom into which the Firmware is intended 
to be installed.

(a)	 “Firmware” shall mean the firmware provided by Aviom that is intended to be installed 
into a specific product of Aviom.

(b)	 “Installation Software” shall mean the software provided by Aviom to enable Licensee to 
install the Firmware into the Aviom Product.

(c)	 “Software” shall mean both the Installation Software and the Firmware, collectively.

1.	 Grant of License.  Subject to the terms and conditions of this Agreement, Aviom grants Licensee 
a limited, non-exclusive license to the object code version of the Software (the “License”).  The License 
permits Licensee to install and use the Installation Software on a single workstation and use the Installation 
Software to flash the Firmware into the Aviom Product(s).  The License also grants Licensee the right to use 
the Firmware on all Aviom Products owned by Licensee.  Licensee may also use the documentation included 
with the Software, if any, (e.g. help files, release notes, and readme.txt files) (collectively, “Documentation”) 
as is reasonable and necessary for Licensee to use the Software.  

2.	 Compensation.  There is no charge for use of the Software by Licensee under the terms and 
conditions of this Agreement.  

3.	 Ownership.  Licensee acknowledges that: (a) the Software is and shall remain the exclusive 
property of Aviom and Aviom’s successors and assigns; (b) Licensee has no right or interest in the Software 
or the Documentation other than as expressly granted in this Agreement; (c) nothing in this Agreement shall 
be construed as a sale of the Software or the Documentation to Licensee; and (d) all intellectual property 
rights shall remain with Aviom and the Agreement shall not transfer any intellectual property rights in, or 
associated with, Software or the Documentation to Licensee. 

4.	 Transfer of License; Copy Protection.  Licensee may not rent, loan, transfer, sublicense, lease or 
otherwise distribute or operate all or any part of the Software to or for the benefit of any third party.  Licensee 
may not assign all or any part of its rights or obligations under this Agreement without Aviom’s prior written 
consent and any attempt to the contrary will be void and a material breach of this Agreement.  Aviom may 
withhold such consent in its sole discretion.  

Other Restrictions.  Licensee may not reverse engineer, decompile, disassemble, modify or create derivative 
works of all or any part of the Software or otherwise derive the source code to all or any part of the Software.  
Without limiting the generality of the foregoing, Licensee shall not use a debugging tool to examine, operate 
or alter all or any part of the Software or run all or any part of the Software through a disassembly or source 
extraction system of any kind or create any derivative work of all or any part of the Software.  Licensee 
agrees that any information obtained in violation of the restrictions as set forth in this Section 6 will be 
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Confidential Information automatically and irrevocably deemed assigned to and owned exclusively by 
Aviom.  Licensee will ensure that all marks, notices or legends pertaining to the origin, identity or ownership 
of the Software or the Documentation remain intact and clearly legible.  Notwithstanding anything contained 
in this Agreement to the contrary, if Licensee is located in the European Union and Licensee determines that 
access to the source code to the Software is necessary to achieve interoperability of the Software with other 
programs, then Licensee may reverse engineer the Software provided that: (a) Aviom has not already made 
available to Licensee the information necessary to achieve interoperability; and (b) Licensee limits its reverse 
engineering activities to those parts of the Software which are necessary to achieve interoperability with such 
programs.
Copyright.

(a)	 The Software and the Documentation contain proprietary material of Aviom and/or material 
that other software and/or information suppliers have licensed to Aviom for use in the Software.  This 
material is protected by copyright and other laws respecting proprietary rights.  Aviom and/or its licensors 
retain all rights in the Software and the Documentation, including (without limitation) all copyright and 
other proprietary rights worldwide in all media.  Licensee may not use all or any part of the Software or the 
Documentation except as expressly permitted under this Agreement and under U.S. and/or other applicable 
copyright laws.

(b)	 While Licensee may make a reasonable number of copies of the Software and the 
Documentation solely for archival/back-up purposes, no part of the Software or the Documentation may 
be used, reproduced or duplicated in any medium or format beyond the express terms of this Agreement 
without prior written authorization from Aviom.  Any use or reproduction not authorized by this Agreement is 
prohibited and shall immediately terminate this Agreement.

(c)	 Licensee acknowledges that the Software and the licensed materials therein are highly 
proprietary in nature and that unauthorized copying, transfer or use may cause Aviom irreparable injury that 
cannot be adequately compensated for by means of monetary damages.  Licensee agrees that any breach 
of this Agreement by Licensee may be enforced by Aviom by means of equitable relief (including, but not 
limited to, injunctive relief) without the necessity of posting any bonds in addition to any other available 
rights and remedies.

5.	 Termination.

(a)	 Termination.  If Licensee: (i) makes or distributes, or fails to prevent others in its control 
from making or distributing, copies of the Software or the Documentation (except as expressly permitted by 
this Agreement) or modifications or derivations thereof; or (ii) breaches any provision of this Agreement, 
then this Agreement shall terminate automatically.

Effect of Termination.  Upon any termination of this Agreement, Licensee shall: (i) immediately discontinue 
use of the Software and the Documentation; (ii) remove the Installation Software and the Documentation 
from all of Licensee’s workstations; and (iii) delete and destroy all copies of the Software and the 
Documentation in its possession or control. Sections 4, 5, 6, 7, 8(b) and 9 through 12 shall survive the 
termination or expiration of this Agreement for any reason in accordance with their respective terms.  

6.	 Disclaimer of Warranties.  AVIOM LICENSES AND PROVIDES THE SOFTWARE AND 
THE DOCUMENTATION TO LICENSEE ON AN “AS-IS” BASIS.  AVIOM HEREBY DISCLAIMS 
ANY AND ALL WARRANTIES AND CONDITIONS WITH REGARD TO THE SOFTWARE AND THE 
DOCUMENTATION, INCLUDING, BUT NOT LIMITED TO, ALL IMPLIED WARRANTIES AND 
CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, ACCURACY, 
TITLE AND NON-INFRINGEMENT.
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7.	 Limitations of Liability.

(a)	 General.  IN NO EVENT WILL AVIOM BE LIABLE FOR DAMAGES ARISING OUT 
OF THE USE OR LICENSING OF THE SOFTWARE OR THE DOCUMENTATION OR ARISING 
UNDER THIS AGREEMENT, WHETHER IN TORT, CONTRACT OR OTHERWISE, TO LICENSEE OR 
ANY OTHER PERSON OR ENTITY INCLUDING ANY DAMAGES CAUSED TO AVIOM PRODUCTS 
FROM USE OF ALL OR ANY PART OF TH E SOFTWARE.

(b)	 Consequential Damages, Etc.  AVIOM SHALL IN NO EVENT BE LIABLE 
TO LICENSEE OR ANY OTHER PERSON OR ENTITY FOR ANY LOST PROFITS, OR 
CONSEQUENTIAL, INCIDENTAL, INDIRECT, PUNITIVE, SPECIAL, OR SIMILAR DAMAGES, 
INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF DATA, DAMAGES TO 
HARDWARE INCLUDING BUT NOT LIMITED TO AVIOM PRODUCTS, IMPAIRMENT OR 
LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, AVIOM 
PRODUCT FAILURE OR MALFUNCTION, LOSS OF WORK PRODUCT, OR ANY AND ALL OTHER 
COMMERCIAL DAMAGES OR LOSSES, DIRECT OR INDIRECT, WHETHER IN TORT, CONTRACT, 
OR OTHERWISE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

(c)	 THE LIMITATIONS OF LIABILITY SET FORTH IN THIS SECTION (I) REFLECT 
AN ALLOCATION OF RISK GIVEN THE AMOUNTS PAYABLE UNDER THIS AGREEMENT 
AND (II) SHALL REMAIN FULLY OPERATIVE EVEN IF THE LIMITED REMEDY SET FORTH 
IN THE AGREEMENT FAILS OF ITS ESSENTIAL PURPOSE OR IS OTHERWISE HELD TO BE 
UNENFORCEABLE.

8.	 Export Regulations.  The transfer of technology across national boundaries is regulated by the U.S. 
Government.  Licensee agrees that Licensee shall not: (a) acquire, ship, transport, export or re-export the 
Software, directly or indirectly, into any country in violation of any applicable law (including, but not limited 
to, the United States Export Administration Act and the regulations promulgated thereunder); or (b) use the 
Software for any purpose prohibited by such laws.

9.	 Miscellaneous.

(a)	 Governing law; Jurisdiction.  The validity, interpretation, rights and obligations of the 
parties and any dispute arising under this Agreement shall be governed by the laws of the Commonwealth 
of Pennsylvania applicable to contracts between residents of Pennsylvania and wholly performed in 
Pennsylvania.  Neither the United Nations Convention on the International Sale of Goods, the 1974 
Convention on the Limitation Period in the International Sale of Goods, nor any amendment or protocol to 
either of the foregoing shall apply to this Agreement or the activities undertaken under or in respect of this 
Agreement.  The state and federal courts with jurisdiction over Chester County, Pennsylvania shall have 
exclusive jurisdiction over any case, controversy or dispute concerning this Agreement or its performance or 
the Software; provided that Aviom may seek injunctive relief in any court of competent jurisdiction.

(b)	 Severability.  If any provision of this Agreement shall be determined to be void, invalid, 
unenforceable or illegal for any reason, then the validity and enforceability of all the remaining provisions 
hereof shall not be affected thereby.

(c)	 Failure to Exercise Rights.  The failure of either party to exercise any of its rights under 
this Agreement for a breach thereof shall not be deemed to be a waiver of those rights or a waiver of any 
subsequent breach of the same or any other provision.

(d)	 Titles.  The titles of the Sections of this Agreement are for convenience only and do not in 
any way limit or amplify the terms and conditions of this Agreement.
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(e)	 Entire Agreement.  This Agreement constitutes the entire understanding between the parties 
with respect to the subject matter of this Agreement and supersedes any and all prior and contemporaneous 
understandings, statements, warranties, representations and agreements, both oral and written, relating 
thereto.  This Agreement cannot be modified except in a writing signed by the party against whom 
enforcement is sought.
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